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 Important Information

Warranty
The VXI-USB is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced by 
receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the 
warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no 
agency, partnership, or joint-venture relationship with National Instruments.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

Compliance with FCC/Canada Radio Frequency Interference 
Regulations

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC 
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only) 
or Class B (for use in residential or commercial locations). All National Instruments (NI) products are FCC Class A products.
Depending on where it is operated, this Class A product could be subject to restrictions in the FCC rules. (In Canada, the 
Department of Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.) Digital 
electronics emit weak signals during normal operation that can affect radio, television, or other wireless products.
All Class A products display a simple warning statement of one paragraph in length regarding interference and undesired 
operation. The FCC rules have restrictions regarding the locations where FCC Class A products can be operated.
Consult the FCC Web site at www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions 
in this manual and the CE marking Declaration of Conformity*, may cause interference to radio and television reception. 
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department 
of Communications (DOC). 
Changes or modifications not expressly approved by NI could void the user’s authority to operate the equipment under the 
FCC Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user is required to correct the interference 
at their own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance with EU Directives
Users in the European Union (EU) should refer to the Declaration of Conformity (DoC) for information* pertaining to the 
CE marking. Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory compliance 
information. To obtain the DoC for this product, visit ni.com/certification, search by model number or product line, 
and click the appropriate link in the Certification column.

* The CE marking Declaration of Conformity contains important supplementary information and instructions for the user or 
installer.
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About This Manual

This manual contains instructions for installing and configuring the 
VXI-USB interface kit. It also discusses how to start developing your 
VXI/VME application.

Conventions
The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on a 
product, refer to the Safety section in Appendix A, Specifications, for 
information about precautions to take.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.
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Related Documentation
The following documents contain information that you might find helpful 
as you read this manual:

• ANSI/IEEE Standard 1014-1987, IEEE Standard for a Versatile 
Backplane Bus: VMEbus

• ANSI/IEEE Standard 1155-1998, IEEE VMEbus Extensions for 
Instrumentation: VXIbus

• ANSI/VITA 1-1994, VME64

• Universal Serial Bus Specification, Revision 2.0

• VXI-6, VXIbus Mainframe Extender Specification, Rev. 2.0, VXIbus 
Consortium

• NI-VISA Help

• NI-VXI Help

• Measurement & Automation Explorer Help for NI-VISA/NI-VXI
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1
Introduction

This chapter describes your VXI-USB interface kit, lists what you need to 
get started, and includes a brief description of the hardware and software. 
The VXI-USB interface kit links a PC-based computer to the VXIbus using 
the Universal Serial Bus (USB). This kit makes your computer perform as 
if it were plugged directly into the VXI backplane, giving your external 
computer the capability of an embedded computer. USB 2.0 features hot 
plug-in capability under Windows, which means you can add and configure 
USB devices without powering down your system. Your kit contains a 
National Instruments VXI-USB interface module, which plugs into your 
VXI mainframe and links your computer to the VXIbus. Your kit includes 
the NI-VXI/NI-VISA bus interface software, which is fully VXIplug&play 
compliant. NI-VXI/NI-VISA is the National Instruments implementation 
of the VISA I/O software standard on which all VXIplug&play software 
components are based.

What You Need to Get Started
To set up and use the VXI-USB interface kit, you need the following items:

❑ Computer running the Windows 2000 or Windows XP operating 
system, with a USB 2.0 port or plug-in card (USB 2.0 plug-in cards 
may not have the same level of performance as an integrated USB 2.0 
port)

❑ VXIbus mainframe

❑ VXI-USB interface module that plugs directly into a VXI mainframe

❑ USB 2.0-compliant cable

❑ National Instruments software CD

❑ This manual
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VXI-USB Interface Kit Overview
The interface kit described in this manual links a USB-equipped computer 
directly to the VXIbus using USB 2.0. The VXI-USB kit uses this 
high-speed (480 Mbps) serial bus to link your computer running Windows 
to a VXI chassis.

Note You can use the VXI-USB kit with USB 1.0, but performance will be significantly 
slower than with USB 2.0 for many types of operations.

Note You can connect multiple USB devices to the host. However, increasing the number 
of USB devices in a system can lower the VXI-USB performance.

The VXI-USB kit includes the NI-VXI/NI-VISA software for Windows, 
a C-size VXI-USB module, and a USB cable. A USB-equipped computer 
connected to a VXI-USB interface can function as a VXI Commander and 
Resource Manager. With the VXI-USB interface kit, your computer 
performs as if it is plugged directly into the VXI backplane as an embedded 
CPU module. The VXI-USB transparently translates between USB and 
VXI protocols.

VXI 3.0 Specification Support
The VXI-USB has been designed for VXIbus Specification 3.0, and also is 
compatible with VXIbus Specification 2.0. The VXI-USB supports new 
VXIbus 3.0 features such as 2eVME transfers (with a theoretical 
bandwidth up to 160 Mbytes/s), A64 memory space allocation, and a 
Resource Manager that supports A64 allocation. NI-VXI includes an 
NI-VISA driver for the VXI-USB that has additional functionality for using 
these VXIbus 3.0 features. If you have a VXI device that supports these 
features, consult the VXI-USB release notes for information about how to 
access them from NI-VISA.

Hardware Description
The VXI-USB module is a VXIbus Slot 0-capable device, so it can reside 
in slot 0 of any C-size or D-size chassis.

Note D-size VXI mainframes have connections for a P3 connector. The VXI-USB, 
however, does not have this connector and cannot provide the necessary control for VXI 
devices that need P3 support.
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The VXI-USB links the computer to the VXIbus and converts USB data 
transfers into VXIbus data transfers and vice versa. The VXI-USB includes 
additional USB Series A ports you can use to connect other USB devices.

VXI-USB Front Panel Features
The VXI-USB has the following front panel features:

• Front panel LEDs

– FAILED—Indicates the VXI-USB is asserting SYSFAIL on the 
bus due to a controller failure.

– SYSFAIL—Indicates the VMEbus SYSFAIL line is asserted by 
the VXI-USB or another device on the bus.

– VXI—Indicates the VXI-USB is being accessed as a VXI slave.

– ONLINE

• Green—Indicates the VXI-USB is configured by Resman.

• Amber—Indicates the VXI-USB is not configured by 
Resman.

– USB—Indicates there is USB traffic to/from the VXI-USB (this 
excludes any traffic to all other downstream USB devices).

– LINK

• Green—Indicates the VXI-USB is connected to a USB host 
and has a full-speed (USB 1.x, 12 Mbps) connection.

• Amber—Indicates the VXI-USB is connected to a USB host 
and has a high-speed (USB 2.0, 480 Mbps) connection.

• One host (Series B) USB connector

• Two device (Series A) USB connectors

• Three SMB connectors

– Trigger input

– Trigger output

– External clock

• System reset pushbutton
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Advanced Configuration Options
The VXI-USB default hardware configuration should be acceptable for 
most systems. Refer to Appendix B, Default Settings, only if your system 
uses the front-panel CLK10 and trigger SMB connectors.

The NI-VISA/NI-VXI bus interface software includes a Resource 
Manager, an interactive configuration and troubleshooting program, 
a comprehensive library of software routines for VXI/VME programming, 
a logging utility you can use for debugging, and graphical interactive 
control programs for interacting with VISA. You can use this software to 
seamlessly program multiple-mainframe configurations and have software 
compatibility across a variety of controller platforms.

NI-VISA has a comprehensive library of software routines not only for 
VXI/VME programming, but also for GPIB, GPIB-VXI, PXI, TCP/IP, and 
Serial. You can use this software to program instruments connected through 
different types of interfaces.

Measurement & Automation Explorer (MAX) helps you view your 
entire test and measurement system and configure various components, 
whether they are VXI, GPIB, PXI, or Serial devices. You can also add 
VME devices to your system easily with MAX and view them on a screen 
display along with the rest of your system. MAX also features various 
options for running the Resource Manager, Resman. You can still execute 
Resman independently to configure your instruments after a power cycle. 
But you can also perform resource manager operations directly from MAX 
or configure it to run Resman automatically at startup.

The NI Spy utility tracks the calls your application makes to National 
Instruments drivers, including NI-VXI, NI-VISA, and NI-488.2. NI Spy 
helps you debug your application by clearly highlighting the functions that 
return errors. You can let NI Spy keep a log of your program’s calls to these 
drivers so that you can check them for errors at your convenience.

National Instruments Application Software
In addition to the NI-VISA/NI-VXI software, you can use the National 
Instruments LabVIEW, Measurement Studio, and LabWindows™/CVI™ 
application programs and instrument drivers to ease your programming 
task. These standardized programs match the modular virtual instrument 
capability of VXI and can reduce your VXI/VME software development 
time. These programs are fully VXIplug&play compliant and feature 
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extensive libraries of VXI instrument drivers written to take full advantage 
of direct VXI control. LabVIEW, Measurement Studio, and 
LabWindows/CVI include all the tools needed for instrument control, data 
acquisition, analysis, and presentation.

LabVIEW is an easy-to-use, graphical programming environment you can 
use to acquire data from thousands of different instruments, including 
IEEE 488.2 devices, VXI devices, serial devices, PLCs, and plug-in data 
acquisition boards. After you have acquired raw data, you can convert it 
into meaningful results using the powerful data analysis routines in 
LabVIEW. LabVIEW also comes with hundreds of instrument drivers, 
which dramatically reduce software development time, because you do not 
need to spend time programming the low-level control of each instrument.

Measurement Studio allows you to choose from standard environments 
such as Microsoft Visual Basic, Visual C++, and Visual Studio .NET to 
create your application, using tools specific for each language. With 
Measurement Studio, you can write programs quickly and easily and 
modify them as your needs change.

LabWindows/CVI is an interactive ANSI C programming environment 
designed for building virtual instrument applications. LabWindows/CVI 
delivers a drag-and-drop editor for building user interfaces, a complete 
ANSI C environment for building your test program logic, and a collection 
of automated code generation tools, as well as utilities for building 
automated test systems, monitoring applications, or laboratory 
experiments. 

To use any of these application programs, install them before installing the 
NI-VISA/NI-VXI software. LabVIEW, Measurement Studio, and 
LabWindows/CVI integrate the VXI and VISA libraries required to support 
your VXI-USB. You also get hundreds of complete instrument drivers, 
which are modular, source-code programs that handle the communication 
with your instrument to speed your application development.
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2
Installation and Configuration

This chapter explains how to set up your test system.

Installing the Software
Use the Setup program that came with your NI-VXI/NI-VISA software to 
install the entire software package or a software update, or to reinstall 
software in the event that your files were accidentally erased. Some of the 
utilities rely on the LabWindows/CVI Run-Time Engine. This software is 
installed, if necessary, during the NI-VXI/NI-VISA installation.

Depending on the type of installation you choose, you may need up to 
50 MB of free space on your hard drive to accommodate the NI-VXI and 
NI-VISA software.

To be compliant with VXIplug&play specifications, a VXI controller must 
provide the VISA I/O driver library standardized by VXIplug&play. VISA 
ensures that your controller can run all VXIplug&play-compatible software 
now and in the future.

The NI-VISA software in this kit is compatible with the WINNT/GWINNT 
framework. With NI-VISA installed on your computer, you can run any 
VXIplug&play software that is compatible with this framework. This 
includes instrument drivers and executable soft front panel software 
included with VXIplug&play-compatible instruments from a variety of 
vendors.

Installing the NI-VXI and NI-VISA Software
This section describes how to install the NI-VXI and NI-VISA software.

Carefully read these directions along with any messages on the screen 
before making your selections. You can quit the Setup program at any time 
by clicking the Cancel button.
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Caution To keep the manufacturer/model name tables or the VME device configuration 
from a previous installation, be sure to back them up before starting Setup. They are in the 
TBL subdirectory of your NI-VXI directory, usually Program Files\National 
Instruments\VXI.

Setup is an interactive, self-guiding program that installs the NI-VXI and 
NI-VISA software and configures your system to use the software with the 
VXI-USB. Complete the following steps to perform the installation:

1. For the CD, select Start»Run and enter the following text, where X is 
your CD drive (usually D):

X:\setup.exe

Press <Enter>. Typically, this setup program runs automatically when 
you insert the CD.

2. Click the Next button at the Welcome screen to start the installation 
and accept the license agreement.

Note If you have a previous version of the NI-VXI software installed, Setup installs the 
new version over the previous version.

3. Select the type of installation from the Installation Options screen.

• Typical setup installs runtime support and NI-VISA development 
support.

• Complete setup installs everything including NI-VXI API 
development support. For more information about the NI-VXI 
API, refer to Chapter 3, Developing Your Application.

• Custom setup gives you more control over which driver 
components you want installed on your system. This option is 
recommended for advanced users.

4. Click the Next button. Confirm that you are ready to install and click 
Next again to begin the installation.

5. Setup now copies the necessary files to your hard drive and creates 
program icons.

Completing the Software Installation
Review the information in any README files that Setup prompts you to 
read.

When the installation process completes, reboot the system for the changes 
to take effect. If you backed up the manufacturer and model name files, 
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restore them to the TBL subdirectory of your NI-VXI directory before 
running MAX.

Note If you save and restore the TBL files from an older version of NI-VXI, the software 
will use TBL files that do not have the latest updates from National Instruments and may 
not include recent hardware releases. If you added additional manufacturer or model names 
to your TBL files, we recommend merging those changes with the latest updates included 
with this version of NI-VXI, so that all your devices are properly identified.

Configuring the Hardware (Optional)
This section contains basic information about configuring your VXI-USB 
hardware. Because the default settings for your VXI-USB hardware are 
acceptable for most typical applications, this section is optional.

Refer to Appendix B, Default Settings, for a complete listing of the 
hardware and software default settings.

Use Measurement & Automation Explorer (MAX) to change any 
VXI-USB configuration settings. You can also use MAX to check for 
software updates, including updates that may be available for the VXI-USB 
firmware. Figure 2-1 shows the firmware update panel.

Figure 2-1.  VXI-USB Firmware Update Panel
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For information about the software, including optional settings, use MAX 
and its online help. Use the Windows Start menu to open the program 
group for National Instruments, launch MAX, and select Help»Help 
Topics.

Installing the Hardware
This section summarizes how to install your VXI-USB hardware. Your kit 
contains a VXI-USB interface module.

Caution To guard against electrostatic discharge, touch the antistatic plastic packages to a 
metal part of your computer or chassis before removing the boards from their packages. 
Your computer or chassis should be plugged in but powered off.

Figure 2-2 shows a system that includes a USB 2.0-equipped computer, a 
VXI-USB, and USB devices.

Figure 2-2.  USB System

1 External Computer
2 Connections to Other USB Devices
3 VXI Mainframe

4 VXI-USB in Slot 0
5 USB Cables

bus
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Installing Your VXI-USB Interface Module
All kits contain a VXI-USB interface module. 

To install the VXI-USB in Slot 0 of your VXI chassis, complete the 
following steps:

1. Power off the chassis.

2. Verify that the backplane connector is intact and that there are no bent 
or missing pins on the module.

3. Insert the VXI-USB into the chassis in Slot 0, as shown in Figure 2-2.

4. Power on the chassis.

The VXI system controllers operate certain VXI lines as required for VXI 
systems. Verify that any other VXI devices with system controller 
capability that are in the same chassis are not configured as system 
controller.

Caution Having more than one device configured as system controller can damage the 
VXI system.

For VXI systems that include VME devices, ensure that the VME devices 
are not configured in the upper 16 KB (starting from 0xC000) of the A16 
address space. This region is reserved for VXI device configuration 
registers, which are used for initializing, configuring, and interacting with 
VXI devices. The VXI-USB also uses this region for this purpose.

Note Also ensure that no VXI devices in your system are configured for logical address 0. 
This is the VXI-USB logical address, which you cannot change.

Connecting Cables
Connect the USB cable to a USB connection in your host PC and to the 
VXI-USB, as shown in Figure 2-2. You can use any available USB port on 
the PC for each device. The VXI-USB has two external ports for devices. 
You can connect any other USB devices to any available port on a 
VXI-USB, but for best performance, minimize the number of USB 
devices/hubs in the system. Adding to the number of devices in the tree 
degrades system performance.

Note Your VXI-USB controller is a Hi-Speed USB device, which means it performs much 
faster when connected to a Hi-Speed USB port as described in the USB 2.0 specification. 
USB 2.0 ports are often integrated on the motherboard of current computers. National 
Instruments recommends using an integrated USB 2.0 port, if available, for optimal 
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performance. Plug-in boards with USB 2.0 ports are also supported but may not provide 
the highest performance. Full-speed (USB 1.x) ports are supported as well, but provide 
much lower performance. The LINK light (refer to Chapter 1, Introduction) on the front 
panel of your VXI-USB controller indicates your connection speed.

Software Configuration and Verification
To configure the software and verify the configuration, follow these steps:

1. Run MAX. You must run the Resource Manager (Resman) every time 
the chassis or computer power is cycled, so that your application can 
access devices in the VXI chassis. You can also configure MAX to run 
Resman automatically at every computer startup by selecting 
Tools»NI-VXI»VXI Options and selecting the appropriate checkbox.

2. You can also use MAX to interactively configure the National 
Instruments hardware in your system. Use the right-click help for 
information about the various configuration options. After you finish 
configuring the system through MAX, verify the configuration 
through the interactive control utility, VISAIC (Start»Programs» 
National Instruments»VISA»VISA Interactive Control), as 
described in Chapter 3, Developing Your Application.

Note If you are using extenders such as MXI-2 to create a multichassis system, you may 
need to run Resman before configuring some of your devices. Also, if you are using 
multiple VXI-USB controllers to create a multisystem configuration, you configure each 
system separately.
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3
Developing Your Application

This chapter discusses the software utilities you can use to start developing 
applications that use NI-VXI.

After installing the NI-VXI software, you can begin developing your 
VXI/VME application. Be sure to check the release notes for the latest 
application development notes and changes.

NI-VXI, NI-VISA, and Related Terms
Before you develop your application, it is important to understand the 
difference between NI-VXI, NI-VISA, and similar terms.

• NI-VXI is the software package that ships with National Instruments 
VXI and VME controllers. NI-VXI includes Measurement & 
Automation Explorer (MAX), NI-VISA, NI Spy, Resource Manager 
(Resman), VXI device drivers, and other utilities for configuring and 
controlling your VXI or VME system.

• NI-VISA is the native API for communicating with VXI/VME devices. 
NI-VISA is the National Instruments implementation of the VISA I/O 
standard, which is a common interface to many types of instruments 
(such as VXI, GPIB, PXI, Serial, TCP/IP, and so on). NI-VXI is 
optimized for use through NI-VISA, and NI recommends using 
NI-VISA to develop all new VXI/VME applications.

• The NI-VXI API is an optional development environment that is not 
part of the default NI-VXI installation. The NI-VXI API was 
developed before NI-VISA; although NI-VXI still supports the 
NI-VXI API, NI recommends using NI-VISA for all new VXI/VME 
applications. If you must develop an application using the older 
NI-VXI API, run the NI-VXI installer and perform a Complete install, 
or select the appropriate option in the custom installation screen. Be 
sure to review the NI-VXI API Notes section.

• The NI-VXI compatibility layer allows older programs that use the 
NI-VXI API to communicate with VXI devices through VISA. Using 
this compatibility layer, older programs can run in NI-VXI 3.0 or later 
without being rewritten to use the VISA interface. This layer installs 
with NI-VXI by default. It should be completely transparent and 



Chapter 3 Developing Your Application

VXI-USB User Manual 3-2 ni.com

provide a high level of performance; however, there may be some 
slight changes in behavior for certain applications.

Your software features several system development utilities including 
MAX, Resman, NI Spy, VISA Interactive Control (VISAIC), and 
optionally VXI Interactive Control (VIC). You can also access online help 
and a variety of examples to learn how to use NI-VXI for certain tasks. 
Each component assists you with one of four development steps: 
configuration, device interaction, programming, and debugging.

You can access the utilities, help files, and release notes through the 
Windows Start menu by opening the National Instruments»VXI or 
National Instruments»VISA program groups.

Configuration
The configuration utilities in your software kit are Resman and MAX. 
Resman performs VXI Resource Manager functions as described in the 
VXIbus specification. Resman configures all devices on the VXI backplane 
for operation and allocates memory for devices that request it. Resman does 
not require you to specify any settings; it automatically performs the VXI 
resource management whenever you run it.

Note Power cycling resets all devices, so you must run Resman to reconfigure your 
system every time you cycle the power on the chassis.

MAX presents a graphical display of your entire test and measurement 
system to help you configure various components. When you launch MAX, 
you see all your devices (including VXI) on the screen. You can view the 
properties (such as logical address, address space, and so on) of each device 
by clicking the device in the configuration tree. To see additional 
configuration options for a given device, right-click the device in the 
configuration tree. When you access the properties of most National 
Instruments devices by right-clicking, you can configure the hardware 
settings by selecting Hardware Configuration.

MAX and Resman are designed to work together. You can run Resman 
through MAX by either clicking the Run VXI Resource Manager button in 
the toolbar or right-clicking a specific VXI system on which to run Resman, 
as shown in Figure 3-1. You can also select Tools»NI-VXI»VXI Resource 
Manager to run Resman on all VXI systems. From the VXI Options dialog 
box in the Tools»NI-VXI menu, you can also use MAX to configure 
Resman to run on all VXI systems automatically when the computer boots. 
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Resman reports to MAX all errors it finds in your system. When you view 
your VXI system in MAX, you can easily spot any errors that Resman 
found while configuring the system.

Figure 3-1.  Right-Click a VXI System in MAX to Run Resman on that System

After Resman detects and configures all your VXI/VME devices, you can 
use MAX to view specific information about each device in your system. 
The default MAX view of a VXI system shows the General tab window, 
which contains a summary of key information about each device, including 
its device name, logical address, model name, and other data. For more 
information about MAX, refer to its online help by selecting the 
Help»Help Topics menu.

Device Interaction
You can interact with your VXI/VME devices using the VISA Interactive 
Control (VISAIC) utility. VISAIC allows you to control your VXI/VME 
devices without using LabVIEW, Measurement Studio, LabWindows/CVI, 
or another programming language. You can also control your devices in 
MAX by right-clicking a device name and selecting Open VISA Session. 

Note You can also use VXI Interactive Control Program (VIC) to control your VXI/VME 
devices and develop and debug VXI application programs. VIC is not included in the 
default NI-VXI installation. To install VIC, choose either a Complete install or select 
NI-VXI API Development from the custom installation screen in the installer. You can 
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launch VISAIC (or VIC) from the Tools menu in MAX or from the VISA or VXI 
subgroups in Start»Programs»National Instruments.

Try the following in VISAIC: In the tree view, navigate using your mouse 
to the VISA resource for your controller—probably VXI0::0::INSTR, 
representing the VXI system 0, logical address 0 instrument resource, as 
shown in Figure 3-2.

Figure 3-2.  Select Your Controller in VISAIC

Open the selected resource and navigate to the Register I/O tab. In this tab, 
you can read registers on your device, such as the VXI device configuration 
registers. Execute the viIn operation (called In in LabVIEW compatibility 
mode) with the default parameters. The Data Value field shows the I/O 
operation result, such as 0x9ff6. The Return Value field shows the 
function status, such as 0 for VI_SUCCESS, as shown in Figure 3-3.
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Figure 3-3.  Successful viIn Access in the VISAIC Register I/O Tab (This Window May 
Look Slightly Different for LabVIEW Users)

If the data value ends in FF6, you have successfully read the National 
Instruments manufacturer ID from your VXI/VME controller’s ID register. 
You may now want to read the configuration registers from other VXI 
devices in your system by opening the devices in VISAIC. Try reading a 
register from each device listed in the MAX view of your VXI system. This 
way, you can verify that your VXI controller can access each device in your 
VXI system successfully. You can also access VXI and VME devices 
configured in A16, A24, or A32 space by opening the VXI MEMACC 
resource, which is VISA’s representation of VXI memory. For more 
information about VISAIC operations and commands, refer to the online 
help in the Help menu and the context-sensitive help (such as What’s 
This?), available by right-clicking in any panel.

Programming for VXI
NI-VISA and the NI-VXI API are the two National Instruments 
programming interfaces for accessing your VXI/VME instruments. With 
NI-VXI 3.0 or later, NI-VISA is the native API for communicating with a 
VXI or VME system, and NI recommends using it for all new applications. 
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Older programs that use the NI-VXI API now use the NI-VXI-to-NI-VISA 
compatibility layer to communicate with the VXI devices. Using this layer, 
older programs can run in NI-VXI 3.0 or later without being rewritten to 
use the VISA interface.

Note The NI-VXI API development environment is not installed by default as part of the 
NI-VXI installation. If you must develop an application using the older NI-VXI API, run 
the NI-VXI installer and perform a Complete install or select the appropriate option in the 
custom installation screen. Be sure to review the NI-VXI API Notes section.

NI-VISA is the National Instruments implementation of the VISA API as 
the VXIplug&play standard defines. It provides a common interface to 
many types of instruments (such as VXI, GPIB, PXI, Serial, TCP/IP, and 
so on) and therefore is especially useful in situations where you are using 
multiple types of instruments.

Both NI-VISA and the NI-VXI API include functions for register-level 
access to VXI instruments and messaging capability to message-based 
devices. You can also use either interface to service asynchronous events 
such as triggers, signals, and interrupts, and also assert them. Compatibility 
with the NI-VXI API is included for legacy applications only—
NI recommends that you write all new VXI/VME applications in VISA.

The best way to learn NI-VISA programming is by reviewing the example 
programs your software includes. The examples directory contains working 
VISA programs that illustrate many different types of applications. You can 
find these examples in the VXIpnp\WinNT\NIvisa\Examples directory.

If you are just getting started, you should learn how to access registers with 
high-level calls and send messages with word-serial functions. The 
NI-VISA examples for these tasks are HighReg.c and RdWrt.c. Refer to 
the other examples as you try more advanced techniques. Consult the 
NI-VISA online help for additional information about these topics.

Table 3-1 summarizes the topics the example programs address. All files 
are in the VXIpnp\WinNT\NIvisa\Examples directory, in the 
subdirectories listed below.
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Note MAX includes configuration options that affect low-level functions and shared 
memory, as well as trigger mappings and other attributes of your VXI system. Refer to the 
MAX online help for information regarding these options.

Optimizing Large VXIbus Transfers
For best performance, keep the following in mind when using viMove() 
or VXImove():

• Make sure your buffers are 32-bit aligned.

• Transfer 32-bit data whenever possible.

• Use VXI block access privileges to significantly improve performance 
to devices that can accept block transfers, and likewise use D64 access 
privileges for devices that can accept the VME64 64-bit data transfer 
protocol.

• To optimize move performance on virtual memory systems such as the 
Windows operating system, lock the user buffer in memory yourself so 
the move operation does not need to lock the buffer.

• To optimize move performance on paged memory systems such as the 
Windows operating system, use a contiguous buffer so the move 
operation does not need to build a scatter-gather list for the user buffer.

Note viMemAlloc() or VXImemAlloc() returns 32-bit aligned, page-locked, 
continuous buffers that work efficiently with the move operations.

Table 3-1.  NI-VISA/NI-VXI Examples

Coverage NI-VISA Example
NI-VXI Example 

(Optional)

Message-Based 
Access

General\RdWrt.c VXIws.c

High-Level 
Register Access

VXI-VME\HighReg.c VXIhigh.c

Low-Level Register 
Access

VXI-VME\LowReg.c VXIlow.c

Interrupt Handling VXI-VME\AsyncIntr.c 
and WaitIntr.c

VXIint.c

Trigger Handling VXI-VME\WaitTrig.c VXItrig.c
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NI-VXI API Notes
The following notes apply only if you are using the NI-VXI API. We 
recommend that all new VXI/VME applications use the NI-VISA API, but 
you can still develop with the older NI-VXI API for compatibility with 
legacy code.

Compiler Symbols
You may need to define certain compiler symbols so that the NI-VXI 
library can work properly with your program. The required symbol 
indicates your operating system platform; for example, VXINT designates 
the application as a Windows 2000/NT/XP/Me/98 application.

Note LabWindows/CVI automatically defines the correct symbol. You do not need to 
define VXINT when using LabWindows/CVI.

The additional symbol BINARY_COMPATIBLE is optional. It ensures that 
the resulting application is binary compatible with other National 
Instruments VXI controllers using the same operating system. This symbol 
may cause a slight performance degradation when you use low-level 
VXIbus access functions on some controllers.

You can define these symbols using #define statements in your source 
code or using the appropriate option in your compiler (typically either –D 
or /D). If you use #define statements, they must appear in your code 
before the line that includes the NI-VXI API header nivxi.h.

Compatibility Layer Options
Although NI-VXI supports multiple VXI controllers through NI-VISA, the 
NI-VXI API supports only a single controller. To specify which controller 
the emulation layer should use, run MAX. Select Tools»NI-VXI»VXI 
Options. Select the VXI system that will support the emulation layer.

In NI-VXI 3.0 or later, when you enable for triggers or interrupts, only the 
local controller is enabled. In the NI-VXI API functions for enabling 
triggers and interrupts, the controller parameter is ignored. If you need to 
enable a remote controller for triggers, use the MAX frame resource to map 
the trigger back to the local controller.

The interrupt and trigger routing in the NI-VXI 3.0 or later low-level 
drivers is somewhat different from the default routing in previous versions 
of NI-VXI. Therefore, the compatibility layer may behave differently than 
the original NI-VXI API with regard to these settings. In particular, if you 
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are receiving triggers on an external controller, you may need to modify the 
trigger configuration on your extender module using MAX. In general, 
interrupts are routed automatically based on the interrupt configuration the 
resource manager detects. Whether the changed routing behavior affects 
your program is application dependent.

Because VISA is an instrument-centric API, certain functions from the 
more controller-centric NI-VXI API do not match perfectly with a VISA 
counterpart. When an application enables an event with the NI-VXI API 
compatibility layer, each logical address is enabled for that event 
separately. For example, if the application enables an interrupt level, VISA 
will enable the interrupt on each logical address, one at a time, until all the 
devices are enabled. This means that some interrupts could be lost from 
devices with higher numbered logical addresses. MAX provides an 
option for users to pick which logical address is enabled first. Select 
Tools»NI-VXI»VXI Options. Set Prioritized Signal LA to the logical 
address of the device that generates the events. This prevents possible loss 
of events from that device.

Debugging
NI Spy and VISAIC are useful utilities for identifying the causes of 
problems in your application.

NI Spy tracks the calls your application makes to National Instruments 
programming interfaces, including NI-VISA, NI-VXI, and NI-488. NI Spy 
highlights functions that return errors, so during development you can 
quickly spot which functions failed during a program’s execution. NI Spy 
can log the calls your program makes to these drivers so you can check 
them for errors at your convenience, or use the NI Spy log as a reference 
when discussing the problem with National Instruments technical support. 
Figure 3-4 shows an example of an error returned from a call to 
viMemAlloc.
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Figure 3-4.  NI Spy

VISAIC, discussed in the Device Interaction section, is an excellent 
platform for quickly testing instruments and learning how to communicate 
with them.

Figure 3-5.  VISAIC
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A
Specifications

This appendix lists the specifications for the VXI-USB module.

Requirements
VXIbus configuration space................... 64 B

Default.................................................... None

Environmental
Maximum altitude .................................. 2,000 m

Pollution Degree .................................... 2

Indoor use only

Operating Environment
Ambient temperature range.................... 0 to 55 °C (Tested in accordance 

with IEC-60068-2-1 and 
IEC-60068-2-2.)

Relative humidity range ......................... 10% to 90% (Tested in 
accordance with 
IEC-60068-2-56.)

Storage Environment
Ambient temperature range.................... –20 to 70 °C (Tested in 

accordance with IEC-60068-2-1 
and IEC-60068-2-2.)

Relative humidity range ......................... 5% to 95% (Tested in accordance 
with IEC-60068-2-56.)

EMI ........................................................ FCC Class A verified, EC verified
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Shock and Vibration
Operational shock ...................................30 g peak, half-sine, 11 ms pulse 

(Tested in accordance with 
IEC-60068-2-27. Test profile 
developed in accordance with 
MIL-PRF-28800F.)

Random vibration

Operating .........................................5 to 500 Hz, 0.3 grms

Nonoperating ...................................5 to 500 Hz, 2.4 grms 
(Tested in accordance with 
IEC-60068-2-64. Nonoperating 
test profile exceeds the 
requirements of 
MIL-PRF-28800F, Class 3.)

Power Requirement
+5 V (excluding downstream USB devices)

Typical.............................................2 A

Maximum ........................................4 A

–5.2 V

Typical.............................................200 mA

Maximum ........................................500 mA

–2 V

Typical.............................................100 mA

Maximum ........................................250 mA

Physical
Size .........................................................C size, C-1

Dimensions ............................................. 23.3 × 43.0 cm (9.2 × 13.4 in.)

Weight ....................................................1.14 kg (2.5 lb)

I/O connectors

USB device (Series A).....................2

USB host (Series B).........................1

SMB.................................................3
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Slot requirements ................................... Single VXI C-size slot

Compatibility ......................................... Fully compatible with VXI 
specification

VXI keying class .................................... Class 1 TTL

MTBF..................................................... Contact factory

USB Capability Description
USB 2.0, backward compatible with USB 1.1 host and devices.

Safety
This product is designed to meet the requirements of the following 
standards of safety for electrical equipment for measurement, control, 
and laboratory use:

• IEC 61010-1, EN 61010-1

• UL 61010-1

• CAN/CSA-C22.2 No. 61010-1

Note For UL and other safety certifications, refer to the product label or visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.

Electromagnetic Compatibility
Emissions ............................................... EN 55011 Class A at 10 m 

FCC Part 15A above 1 GHz

Immunity................................................ EN 61326:1997 + A2:2001, 
Table 1

CE, C-Tick, and FCC Part 15 (Class A) Compliant

Note For EMC compliance, operate this device with shielded cabling.
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CE Compliance
This product meets the essential requirements of applicable European 
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety)..............73/23/EEC

Electromagnetic Compatibility 
Directive (EMC) .....................................89/336/EEC

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 
regulatory compliance information. To obtain the DoC for this product, visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.

Cleaning
If you need to clean the module, use a soft, nonmetallic brush. Make sure 
that the module is completely dry and free from contaminants before 
returning it to service.

VMEbus Capability Codes
A64, A32, A24, A16 (master)

VMEbus master A64, A32, A24, and A16 addressing

A16 (slave)

VMEbus slave A16 addressing

D64, D32, D16, D08(EO) (master)

VMEbus master D64, D32, D16, and D08 data sizes

D16, D08(EO) (slave)

VMEbus slave D16 and D08 data sizes

BLT, MBLT (master)

VMEbus master block and D64 transfers

RMW (master)

VMEbus master read/modify/write transfers

RMW (slave)

VMEbus slave read/modify/write transfers
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RETRY (master)

VMEbus master retry support

RETRY (slave)

VMEbus slave retry support

FSD

First slot detector

SCON

VMEbus System Controller (Automatic Detection)

PRI, RRS

Prioritized or Round Robin Select arbiter

ROR, FAIR

Release on Request and FAIR bus requester

IH(7-1)

Interrupt handler for levels 7–1

I(7-1)

Interrupt requester for levels 7–1

D32, D16, D08(O) (Interrupt Handler)

VMEbus D32, D16, D08(O) interrupt handler

D32, D16, D08(O) (Interrupter)

VMEbus D32, D16, D08(O) interrupter

ROAK, RORA

Release on Acknowledge or Register Access interrupter

BTO(x)
VMEbus bus timer (programmable limit)

LOCK

Can lock the VMEbus for indivisible transfers
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B
Default Settings

This appendix summarizes the default settings for the hardware and 
software in the VXI-USB kit. If you need more information about a 
particular setting or want to try a different configuration, refer to 
Appendix C, Advanced Hardware Configuration Settings, for your 
hardware reference and to the MAX online help for your software 
reference.

Default Hardware Settings
Figure B-1 and Table B-1 show the factory-default settings of the 
user-configurable switches on the VXI-USB.
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Figure B-1.  VXI-USB Default Configuration Settings
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Default Software Settings

Table B-1.  VXI-USB Hardware Default Settings

Hardware Component Default Setting

S1—Firmware recovery N: do not recover firmware

S2—VXIbus CLK10 source From onboard oscillator

S3—SMB trigger in termination ON: terminated

S4—SMB CLK10 in termination ON: terminated

S5—SMB CLK10 direction IN: receive CLK10 signal

S6—SMB CLK10 out polarity Noninverted

Table B-2.  MAX USB Tab Default Settings

Editor Field Default Setting

USB block size 64 KB

Table B-3.  MAX VXI Bus Tab Default Settings

Editor Field Default Setting

Bus timeout value 500 µs

VXI retry generation Enabled

Automatic retries Disabled

A24/A32 write posting Disabled

Transfer limit (bytes) 256/2048 for 2eVME protocol

Requester mode Release on Request

Request level 3

Fair requester Enabled

Bus arbitration mode Prioritized

Arbiter timeout Enabled
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C
Advanced Hardware 
Configuration Settings

This appendix describes the alternate hardware configuration settings of the 
VXI-USB. The board is set at the factory for the most commonly used 
configuration. Use this appendix if you want to try a different hardware 
configuration or if you would like more information on a particular setting. 
This information is intended for more advanced users.

The following hardware configuration settings are user configurable.

• Firmware recovery

• VXIbus CLK10 routing

• Trigger input termination

For the configuration switch locations and default settings, see Figure B-1, 
VXI-USB Hardware Default Settings.

Note Do not attempt an alternate setting unless you are familiar with its purpose. 
In addition, do not reconfigure any switches or jumpers not described in this appendix 
unless directed by National Instruments support.

Firmware Recovery
The VXI-USB has an onboard EEPROM and flash memory that stores 
default hardware behaviors loaded at power-on.

The Firmware Recovery Setting switch (S1) causes the VXI-USB to boot 
from the firmware image stored on the host. This is useful in the event that 
the onboard firmware memory becomes corrupted in such a way that the 
VXI-USB boots to an unusable state.

Figure C-1 shows the configuration settings for firmware recovery 
operation.
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Figure C-1.  Firmware Recovery Operation

VXIbus CLK10 Routing
The VXI-USB has four hardware switches that work together to control 
various aspects of CLK10 routing. Read this section carefully and notice 
that if you change one switch, you may need to change another. This section 
includes several diagrams that show how to configure the four switches to 
accomplish various CLK10 configurations.

Notice that the configuration of one switch may make the setting of another 
switch irrelevant. The drawings use the  pattern to depict switches that 
are either irrelevant or disabled for a particular CLK10 configuration.

Switch S3 uses this pattern in all of the CLK10 drawings. It deals with the 
external trigger input SMB and is discussed later in this appendix.

The VXI-USB can use two different sources to generate the VXIbus 
CLK10 signal—an onboard oscillator or the external CLK SMB connector. 
Use switch S2 to select between these options. The VXI-USB uses the 
onboard oscillator by default.

The VXI-USB can also be configured to drive the external CLK SMB from 
the VXIbus CLK10 signal. Switch S5 controls whether the VXI-USB 
drives or receives the external CLK SMB. If you change the S5 setting to 
drive CLK10 out the external CLK10 SMB connector, do not set switch S2 
to receive the SMB CLK10 signal. Instead, use its default setting so that the 
onboard oscillator generates the signal.

You can use an additional switch, S6, to control the polarity of the external 
CLK SMB signal when S5 is configured to drive it. S6 is unused when S5 
is configured to receive the external CLK SMB signal.

A. Boot from Onboard EEPROM
and Flash Memory (Default)

B. Boot from Firmware 
Image Stored on Host

S1

Y

N

Y

N

S1
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When switch S5 is set so that the VXI-USB receives the SMB CLK10 
signal, you have the option to add a 50 Ω termination to the signal by setting 
switch S4. S4 is unused when S5 is configured to drive the external CLK 
SMB signal.

Table C-1 summarizes the most common configuration types.

Figure C-2 shows the default settings for the CLK10 switches. This 
configuration is as follows:

• CLK10 is generated from the onboard oscillator (S2).

• The CLK10 signal is terminated (S4).

• The VXI-USB receives the external CLK10 signal (S5).

• The polarity of the CLK10 signal (S6) is irrelevant when the VXI-USB 
receives the external CLK10 signal. However, it is configured to be 
noninverted when the CLK10 SMB is used as output.

Table C-1.  Common CLK10 Routing Configurations

Description

Switches

S2 CLK10 
Source

S4 
Terminate

S5 
Direction

S6 
Polarity

Generate internal CLK10 with 
onboard oscillator

ONBRD N/A IN N/A

Generate internal CLK10 and drive 
to external CLK SMB

ONBRD N/A OUT NON

Generate internal CLK10 and drive 
inverted to external CLK SMB

ONBRD N/A OUT INV

Receive external CLK SMB and 
drive to the backplane unterminated

SMB N IN N/A

Receive external CLK SMB with 
50 Ω termination and drive to the 
backplane

SMB Y IN N/A
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Figure C-2.  Default Settings for CLK10 Switches

In Figures C-3 and C-4, switch S2 uses the alternate configuration to 
generate the VXIbus CLK10 signal. Instead of the onboard oscillator, the 
VXI-USB generates from the external CLK SMB connector and drives to 
the backplane. You can choose whether to terminate the signal using S4. 
Polarity remains irrelevant to these configurations.

Figure C-3.  Receive External CLK SMB and Drive to the Backplane Unterminated
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Figure C-4.  Receive External CLK SMB with 50 Ω Termination 
and Drive to the Backplane

Figures C-5 and C-6 show two configurations for driving the external CLK 
SMB from the VXIbus CLK10 signal by changing switch S5 to its alternate 
setting. Switch S2 must be in its default position for these configurations. 
Signal termination is not an issue when driving the signal, so the position 
of S4 does not matter. The difference between these two configurations is 
whether to use inverted or noninverted polarity when driving the signal.

Figure C-5.  Drive Inverted External CLK SMB
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Figure C-6.  Drive Noninverted External CLK SMB

Trigger Input Termination
Located within the group of CLK10 switches is switch S3, which controls 
whether to put a 50 Ω termination on the external trigger input SMB. 
Figure C-7 shows the setting for a nonterminated trigger input SMB. Use 
the default setting of Figure C-7B to terminate the trigger input SMB.

Figure C-7.  SMB Trigger Input Termination

S3 S4 S5 S6

OUT

IN

S2

From 
Onboard
Oscillator

From SMB
CLK10 In

S1

Inverted

Noninverted

A. Does Not Terminate
Trigger Input

B. Terminate Trigger
Input (Default)

S3 S4 S5 S6

S2S1

ON

OFF

S3 S4 S5 S6

S2S1

ON

OFF



© National Instruments Corporation D-1 VXI-USB User Manual

D
Common Questions

This appendix addresses common questions you may have about using the 
NI-VISA/NI-VXI software on the VXI-USB platform.

What does hot plugging mean in terms of USB?

The concept of hot plugging in USB means that you can remove and insert 
USB cables without powering down your computer and devices. The USB 
Plug and Play architecture is designed so that the host computer can 
recognize when to load and remove the appropriate drivers.

Does it matter if I plug my VXI-USB or other USB device into any 
particular USB port? For example, does it matter whether I plug a 
USB device into the USB ports in my computer or into the VXI-USB in 
my mainframe?

A USB device may be plugged into any port on the VXI-USB or your 
computer. Doing so can change the topology of the system, which may 
affect system performance in some cases. The effect may vary greatly, 
depending on the system and types of devices installed.

Also, if your computer has integrated USB 2.0, you should use one of the 
integrated ports rather than a USB 2.0 plug-in card if possible. Integrated 
USB 2.0 ports typically offer better performance due to their tight coupling 
with your motherboard and chipset. Of course, if you have the choice 
between a USB 2.0 port and a USB 1.x port, always use the USB 2.0 port 
even if that means you are using a plug-in card instead of an integrated port.

I need more devices than can fit in one chassis. How can I expand my 
VXI-USB system?

You can add another VXI-USB to the system, but the additional chassis will 
not share the same VXI bus. The recommended strategy is to use a 
VXI-MXI-2, which follows the VXI-6 specification for mainframe 
extension. This extends full VXI functionality across multiple mainframes, 
including a common device address space and interframe triggering, 
interrupts, and bus mastering. Place a VXI-MXI-2 in the same frame as the 
Slot 0 VXI-USB, and another VXI-MXI-2 in Slot 0 of the next mainframe. 
You can then fill up this mainframe with additional devices.



Appendix D Common Questions

VXI-USB User Manual D-2 ni.com

How can I determine the serial number and firmware version of the 
VXI-USB module?

This information is displayed in the title bar of the Hardware Configuration 
window in MAX.

What is Resman?

Resman is the utility that performs the duties of a VXI Resource Manager 
as discussed in the VXIbus specification. When you set a National 
Instruments controller to Logical Address 0, you will at some point need to 
run Resman to configure your VXI instruments. If your controller uses a 
different (nonzero) logical address and is a message-based device, you need 
to start Resman before running it on the Logical Address 0 computer. The 
VXI-USB is always logical address 0.

When do I need to run Resman?

Run Resman whenever you need to configure your VXI instruments (for 
example, when you power cycle either the host computer or the chassis). 
You do not need to run Resman if you unplug your USB cable from the host 
and plug it in again without power cycling either the chassis or the host 
computer.

Which NI-VXI utility program must I use to configure the VXI-USB?

Use MAX to configure the VXI-USB. MAX is in the National 
Instruments program group folder, and a shortcut is on your desktop.

How do I handle VME devices?

Although there is no way to automatically detect VME devices in a system, 
you can add them easily through the Add Device Wizard in MAX. Through 
this procedure, you can reserve resources for each of your VME devices 
and configure MAX to show VME devices on the screen with all your other 
devices.

Which NI-VXI utility program must I use to perform startup Resource 
Manager operations?

Use the Resman program to perform startup Resource Manager operations 
in Start»Programs»National Instruments»VXI. Resman uses the 
settings configured in MAX. It initializes your VXI/VMEbus system and 
makes the information it collects accessible through MAX. You can also 
run Resource Manager operations from MAX. Through MAX, you can also 
configure Resman to run automatically at startup.
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What can I do to make sure that my system is up and running?

The fastest method for testing the system is to run Resman. This program 
attempts to access memory in the upper A16 address space of each device 
in the system. If Resman does not report any problems, the VXI-USB 
communication system is operational. To test individual devices, you can 
use the VIC or VISAIC program to interactively issue NI-VXI functions or 
NI-VISA operations, respectively. You can use viIn() and viOut() with 
the NI-VISA API (or VXIin() or VXIinReg() and VXIout() or 
VXIoutReg() with the NI-VXI API) to test register-based devices by 
programming their registers. If you have any message-based devices, you 
can send and receive messages with the viRead() and viWrite() 
operations in the NI-VISA API (or WSrd() and WSwrt() functions in the 
NI-VXI API). Notice that VXIinReg() and VXIoutReg() are for VXI 
devices only, but you can use VXIin() and VXIout() for both VXI and 
VME. Finally, if you are using LabVIEW or LabWindows/CVI and you 
have instrument drivers for the devices in your chassis, you can use the 
interactive features of these programs to quickly test the functionality of the 
devices.

What do the LEDs on the front of the VXI-USB mean?

The VXI-USB has the following front panel LEDs:

• FAILED—Indicates the VXI-USB is asserting SYSFAIL on the bus 
due to a controller failure.

• SYSFAIL—Indicates the VMEbus SYSFAIL line is asserted by the 
VXI-USB or another device on the bus.

• VXI—Indicates the VXI-USB is being accessed as a VXI slave.

• ONLINE

– Green—Indicates the VXI-USB is configured by Resman.

– Amber—Indicates the VXI-USB is not configured by Resman.

• USB—Indicates there is USB traffic to/from the VXI-USB (this 
excludes any traffic to all other downstream USB devices).

• LINK

– Green—Indicates the VXI-USB is connected to a USB host and 
has a full-speed (USB 1.x, 12 Mbps) connection.

– Amber—Indicates the VXI-USB is connected to a USB host and 
has a high-speed (USB 2.0, 480 Mbps) connection.

When all six LEDs are solid on, the FPGA image is corrupted. Recover the 
firmware to repair the board.
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When all LEDs except the SYSFAIL LED are on, the hardware detected 
that the FPGA PLL lost lock, and the board may be in an unstable state. 
Power cycle the board to repair it.

In an empty chassis, when both the SYSFAIL and FAIL LEDs are solid on, 
the firmware image is corrupted. Recover the firmware to repair the board.

What kind of signal is CLK10 and what kind of signal do I need for an 
external CLK10?

CLK10 is a differential ECL signal on the VXIbus backplane. However, the 
oscillator for the VXI-USB and the EXT CLK input from the front panel 
use TTL. Therefore, supply a TTL-level signal for EXT CLK, and onboard 
voltage converters automatically convert the signal to differential ECL.

What is the accuracy of the CLK10 signal?

The CLK10 generated by the VXI-USB is ±100 ppm accurate. If you need 
a more accurate CLK10 signal, you can use the EXT CLK input at the front 
of the VXI-USB.
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E
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 
ni.com for technical support and professional services:

• Support—Online technical support resources at ni.com/support 
include the following:

– Self-Help Resources—For answers and solutions, visit the 
award-winning National Instruments Web site for software drivers 
and updates, a searchable KnowledgeBase, product manuals, 
step-by-step troubleshooting wizards, thousands of example 
programs, tutorials, application notes, instrument drivers, and 
so on.

– Free Technical Support—All registered users receive free Basic 
Service, which includes access to hundreds of Application 
Engineers worldwide in the NI Developer Exchange at 
ni.com/exchange. National Instruments Application Engineers 
make sure every question receives an answer.

For information about other technical support options in your 
area, visit ni.com/services or contact your local office at 
ni.com/contact. 

• Training and Certification—Visit ni.com/training for 
self-paced training, eLearning virtual classrooms, interactive CDs, 
and Certification program information. You also can register for 
instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, National Instruments 
Alliance Partner members can help. To learn more, call your local 
NI office or visit ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

p pico 10–12

n nano 10–9

µ micro 10– 6

m milli 10–3

k kilo 103

M mega 106

G giga 109

T tera 1012

Symbols

° degrees

Ω ohms

A

A amperes

address Character code that identifies a specific location (or series of locations) in 
memory. In VISA, it identifies a resource.

address modifier One of six signals in the VMEbus specification used by VMEbus masters 
to indicate the address space in which a data transfer is to take place.

address space A set of 2n memory locations differentiated from other such sets in 
VXI/VMEbus systems by six addressing lines known as address modifiers. 
n is the number of address lines required to uniquely specify a byte location 
in a given space. Valid numbers for n are 16, 24, 32, and 64. In VME/VXI, 
because there are six address modifiers, there are 64 possible address 
spaces.
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ANSI American National Standards Institute

API Application Programming Interface—the direct interface that an end user 
sees when creating an application.

arbitration A process in which a potential bus master gains control over a particular 
bus.

B

B Byte—eight related bits of data, an 8-bit binary number. Also used to 
denote the amount of memory required to store one byte of data.

backplane An assembly, typically a printed circuit board, with 96-pin connectors and 
signal paths that bus the connector pins. A C-size VXIbus system will have 
two sets of bused connectors called J1 and J2. A D-size VXIbus system will 
have three sets of bused connectors called J1, J2, and J3.

BERR* bus error signal

BIOS Basic Input/Output System. BIOS functions are the fundamental level 
of any PC or compatible computer. BIOS functions embody the basic 
operations needed for successful use of the computer’s hardware resources.

block-mode transfer An uninterrupted transfer of data elements in which the master sources only 
the first address at the beginning of the cycle. The slave is then responsible 
for incrementing the address on subsequent transfers so that the next 
element is transferred to or from the proper storage location. A VME data 
transfer may have no more than 256 elements.

bus The group of conductors that interconnect individual circuitry in a 
computer. Typically, a bus is the expansion vehicle to which I/O or other 
devices are connected. Examples of buses include the ISA bus, PCI bus, 
VXI bus, and VME bus.

bus error An error that signals failed access to an address. Bus errors occur with 
low-level accesses to memory and usually involve hardware with bus 
mapping capabilities. For example, nonexistent memory, a nonexistent 
register, or an incorrect device access can cause a bus error.

bus master A device that is capable of requesting the Data Transfer Bus (DTB) for the 
purpose of accessing a slave device.
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byte order How bytes are arranged within a word or how words are arranged within 
a longword. Motorola ordering stores the most significant byte (MSB) or 
word first, followed by the least significant byte (LSB) or word. Intel 
ordering stores the LSB or word first, followed by the MSB or word.

C

C Celsius

CLK10 A 10 MHz, ±100 ppm, individually buffered (to each module slot), 
differential ECL system clock that is sourced from Slot 0 of a VXIbus 
mainframe and distributed to Slots 1 through 12 on P2. It is distributed to 
each slot as a single-source, single-destination signal with a matched delay 
of under 8 ns.

Commander A message-based device that is also a bus master and can control one or 
more Servants.

configuration registers A set of registers through which the system can identify a module 
device type, model, manufacturer, address space, and memory 
requirements. To support automatic system and memory configuration, 
the VXI specification requires that all VXIbus devices have a set of such 
registers.

D

Data Transfer Bus DTB; one of four buses on the VMEbus backplane. The DTB is used by a 
bus master to transfer binary data between itself and a slave device.

DMA Direct Memory Access—a method by which data is transferred between 
devices and internal memory without intervention of the central processing 
unit. DMA is the fastest method of transferring data to/from computer 
memory.

DRAM Dynamic RAM (Random Access Memory)—storage that the computer 
must refresh at frequent intervals.

dynamic 
configuration

A method of automatically assigning logical addresses to VXIbus devices 
at system startup or other configuration times.
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dynamically 
configured device

A device that has its logical address assigned by the Resource Manager. 
AVXI device initially responds at Logical Address 255 when its MODID 
line is asserted. The Resource Manager subsequently assigns it a new 
logical address, to which the device responds until powered down.

E

ECL Emitter-Coupled Logic

EEPROM Electronically Erasable Programmable Read Only Memory—ROM that 
can be erased with an electrical signal and reprogrammed.

embedded controller An intelligent CPU (controller) interface plugged directly into the VXI 
backplane, giving it direct access to the VXIbus. It must have all of its 
required VXI interface capabilities built in.

EMC electromagnetic compliance

EMI electromagnetic interference

external trigger A voltage pulse from an external source that triggers an event.

F

fair requester A VXIbus device that will not arbitrate for the VXIbus after releasing 
it until it detects the bus request signal inactive. This ensures that all 
requesting devices will be granted use of the bus.

firmware Software embedded in the VXI-USB, contained on EEPROM and flash 
memory that can be updated with a special utility (part of MAX). In 
combination with the hardware, the firmware enables the VXI-USB to act 
as a translator between USB and VXI protocols.

G

g (1) grams
(2) a measure of acceleration equal to 9.8 m/s2

GPIB General Purpose Interface Bus (IEEE 488)

gRMS A measure of random vibration. The root mean square of acceleration 
levels in a random vibration test profile.
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H

hex Hexadecimal—the numbering system with base 16, using the digits 0 to 9 
and letters A to F.

Hz hertz; cycles per second

I

I/O Input/output—the techniques, media, and devices used to achieve 
communication between machines and users.

IEC International Electrotechnical Commission. The IEC publishes 
internationally recognized standards. IEC 60068 contains information 
on environmental testing procedures and severities.

IEEE Institute of Electrical and Electronics Engineers

in. inches

instrument driver A set of routines designed to control a specific instrument or family of 
instruments, and any necessary related files for LabWindows/CVI or 
LabVIEW.

interrupt A means for a device to request service from another device; a computer 
signal indicating that the CPU should suspend its current task to service a 
designated activity.

interrupt handler A VMEbus functional module that detects interrupt requests generated by 
interrupters and responds to those requests by requesting status and identify 
information.

interrupt level The relative priority at which a device can interrupt.

IRQ* interrupt signal

K

K kilo—the prefix for 1,024, or 210, used with B (byte) in quantifying data or 
computer memory.

k kilo—the standard metric prefix for 1,000, or 103, used with units of 
measure such as volts, hertz, and meters.
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L

logical address An 8-bit number that uniquely identifies each VXIbus device in a system. 
It defines the A16 register address of a device, and indicates Commander 
and Servant relationships.

M

m meters

M mega—(1) the standard metric prefix for 1 million or 106, when used with 
units of measure such as volts and hertz; (2) the prefix for 1,048,576, or 220, 
when used with B (byte) to quantify data or computer memory.

master A functional part of a VME/VXIbus device that initiates data transfers on 
the backplane. A transfer can be either a read or a write.

message-based
device

An intelligent device that implements the defined VXIbus registers and 
communication protocols. These devices are able to use Word Serial 
Protocol to communicate with one another through communication 
registers.

MODID Module ID lines—used in VXI to geographically locate boards and to 
dynamically configure boards.

MTBF Mean Time Between Failure

MXI-3 A PCI Master/Slave system implementing the PCI-to-PCI Bridge register 
set. It couples two physically separate PCI buses with either a copper or 
fiber optic data link capable of 1.5 Gbits/s serial data rates.

N

NI-488.2 or
NI-488.2M

The National Instruments industry-standard software for controlling 
GPIB instruments.

NI-DAQ The National Instruments industry-standard software for data acquisition 
instruments.

NI-VISA The National Instruments implementation of the VISA standard; an 
interface-independent software that provides a unified programming 
interface for VXI, GPIB, and serial instruments.
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NI-VXI The National Instruments bus interface software for VME/VXIbus 
systems.

Non-Slot 0 device A device configured for installation in any slot in a VXIbus mainframe 
other than Slot 0. Installing such a device into Slot 0 can damage the device, 
the VXIbus backplane, or both.

P

PCI Peripheral Component Interconnect. The PCI bus is a high-performance 
32-bit or 64-bit bus with multiplexed address and data lines.

R

register-based device A Servant-only device that supports VXIbus configuration registers. 
Register-based devices are typically controlled by message-based devices 
via device-dependent register reads and writes.

Resman The name of the National Instruments Resource Manager in NI-VXI bus 
interface software. See Resource Manager.

Resource Manager A message-based Commander located at Logical Address 0, which 
provides configuration management services such as address map 
configuration, Commander and Servant mappings, and self-test and 
diagnostic management.

retry An acknowledge by a destination that signifies that the cycle did not 
complete and should be repeated.

RMS Root mean squared. See gRMS.

S

s seconds

slave A functional part of a VME/VXIbus device that detects data transfer cycles 
initiated by a VMEbus master and responds to the transfers when the 
address specifies one of the device’s registers.
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Slot 0 device A device configured for installation in Slot 0 of a VXIbus mainframe. This 
device is unique in the VXIbus system in that it performs the VXI/VMEbus 
System Controller functions, including clock sourcing and arbitration for 
data transfers across the backplane. Installing such a device into any other 
slot can damage the device, the VXIbus backplane, or both.

SMB Sub Miniature Type B connector that features a snap coupling for fast 
connection.

statically configured 
device

A device whose logical address cannot be set through software; that is, it is 
not dynamically configurable.

SYSFAIL A VMEbus signal that is used by a device to indicate an internal failure. 
A failed device asserts this line. In VXI, a device that fails also clears its 
PASSed bit in its Status register.

T

trigger Either TTL or ECL lines used for intermodule communication.

TTL Transistor-Transistor Logic

U

USB Universal Serial Bus—a serial bus for connecting computers to keyboards, 
printers, and other peripheral devices.

V

V volts 

VIC VXI Interactive Control program, a part of the NI-VXI bus interface 
software. Used to program VXI devices and develop and debug VXI 
application programs.

VISA Virtual Instrument Software Architecture. This is the general name given 
to VISA and its associated architecture.

VISAIC VISA Interactive Control program, a part of the NI-VISA software. 
Used to program devices and develop and debug application programs.

VITA VMEbus International Trade Association
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VME Versa Module Eurocard or IEEE 1014

VMEbus System 
Controller

A device configured for installation in Slot 0 or a VXIbus mainframe or the 
first slot in a VMEbus chassis. This device is unique in the VMEbus system 
in that it performs the VMEbus System Controller functions, including 
clock sourcing and arbitration for data transfers across the backplane. 
Installing such a device into any other slot can damage the device, the 
VMEbus/VXIbus backplane, or both.

VXIbus VMEbus Extensions for Instrumentation

W

W watts

Word Serial Protocol The simplest required communication protocol supported by 
message-based devices in a VXIbus system. It utilizes the A16 
communication registers to transfer data using a simple polling handshake 
method.

write posting A mechanism that signifies that a device will immediately give a successful 
acknowledge to a write transfer and place the transfer in a local buffer. The 
device can then independently complete the write cycle to the destination.
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Index

A
advanced configuration options, 1-4
advanced hardware configuration settings, C-1
application development, 3-1

configuration, 3-2
debugging, 3-9
device interaction, 3-3
NI-VXI API notes, 3-8
optimizing large VXIbus transfers, 3-7
programming for VXI, 3-5

C
cables, connecting, 2-5
CE compliance specifications, A-4
cleaning specifications, A-4
CLK10 routing, VXI bus, C-2
CLK10 signal

accuracy, D-4
definition, D-4

CLK10 switches, default settings (figure), C-4
common CLK10 routing configurations 

(table), C-3
common questions, D-1
compatibility layer options, 3-8
compiler symbols, 3-8
completing software installation, 2-2
configuration, 2-1, 3-2

advanced hardware settings, C-1
advanced options, C-1
firmware recovery, C-1
options, 1-4
VXI-USB default configuration settings 

(figure), B-2
connecting cables, 2-5
conventions used in the manual, vii

D
debugging, 3-9
default configuration settings, B-1
default settings

hardware, B-1
software, B-3

developing applications, 3-1
device interaction, 3-3
device tab default settings (table), B-3
diagnostic tools (NI resources), E-1
documentation

conventions used in manual, vii
NI resources, E-1
related documentation, viii

drivers (NI resources), E-1

E
electromagnetic compatibility 

specifications, A-3
environmental specifications, A-1
examples (NI resources), E-1

F
firmware recovery configuration, C-1
front panel features, 1-3

G
getting started, 1-1

H
hardware

advanced configuration settings, C-1
configuration, 2-3, 3-2
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default settings, B-1
description, 1-2
determining revision, D-2
installation, 2-4

help, technical support, E-1
hot plugging, D-1

I
installation, 2-1

hardware, 2-4
software, 2-1

instrument drivers (NI resources), E-1
introduction, 1-1

K
KnowledgeBase, E-1

L
LabVIEW, 1-5
LabWindows/CVI, 1-5
LEDs, 1-3, D-3

M
Measurement & Automation Explorer, 1-4

device tab default settings (table), B-3
VXI bus tab default settings (table), B-3

Measurement Studio, 1-5

N
National Instruments

application software, 1-4
support and services, E-1

NI Spy, 3-9
(figure), 3-10

NI support and services, E-1

NI-VISA, 1-4, 3-1
examples (table), 3-7
installation, 2-1

NI-VXI, 1-4, 3-1
compatibility layer, 3-1
examples (table), 3-7
installation, 2-1
utility programs

using to configure VXI-USB, D-2
using to perform startup Resource 

Manager operations, D-2
NI-VXI API, 3-1

compatibility layer options, 3-8
compiler symbols, 3-8
notes, 3-8

O
optimizing large VXIbus transfers, 3-7
overview of VXI-USB kit, 1-2

P
physical specifications, A-2
power requirement specifications, A-2
programming examples (NI resources), E-1
programming for VXI, 3-5

R
Register I/O tab, successful viIn access in 

(figure), 3-5
related documentation, viii
requirement specifications, A-1
Resman, 1-4, D-2

running (figure), 3-3
using to ensure system is up and 

running, D-3
when to run, D-2

Resource Manager, 1-4
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S
safety specifications, A-3
selecting controller in VISAIC (figure), 3-4
serial number, determining, D-2
shock and vibration specifications, A-2
software

configuration, 2-6
installation, 2-1

completing, 2-2
verification, 2-6

software (NI resources), E-1
specifications, A-1

CE compliance, A-4
cleaning, A-4
electromagnetic compatibility, A-3
environmental, A-1
physical, A-2
power requirement, A-2
requirements, A-1
safety, A-3
shock and vibration, A-2
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